
 
 
 
 
 
 
 

Microsoft Office’s spreadsheet application can be used to track 

and analyze numerical data for display on screen or in printed 

format. Excel is designed to help you record and calculate data, 

and present it in a clear and attractive manner. Excel provides you 

with various chart and layout options to enhance your 

spreadsheets. For example teachers can enter the marks obtained 

by students in exams and automatically calculate the grades. A 

person buying and selling equity can easily calculate the 

gains/losses of the transactions and maintain an excellent record 

of his held shares. You can maintain and check your bank 

account. People planning to take a car or home loan can easily 

figure out their EMIs (Equal monthly Installments). This e-book will 

help you to take full advantage of Excel’s many abilities. For many 

free Excel training videos you can visit our website at 

http://www.familycomputerclub.com. 
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About the Excel Window 
Excel provides an interface (graphical tools and controls) for working with 
worksheet data. This topic will help you identify the purpose of the tool and 
indicators that appear in the Excel window. 



TIP: You can set Windows to show more screen area, thereby showing more Excel 
workspace and toolbar buttons: Right-click the desktop, click Properties, click the 
Settings tab, then adjust the slider to select a resolution appropriate to your vision and 
monitor size. The screen area in the illustration above is set to 800 by 600 pixels. 

 

 
 
 
 
 
 
 
 

The Microsoft Excel Window 
Application window control icon:  Click to access a drop-down menu of commands that 
control the position and size of the application window. 
 
Close, Maximize, and Minimize buttons: Click buttons to close, maximize, or 
minimize the Excel window. 
 
Formula Bar: Provides a space for typing or editing cell data. 
 
Microsoft Excel title bar: Displays the program name (Microsoft Excel), and may also 
display the file name of an open workbook window, if the workbook is maximized. You 
can drag the title bar to move the window, or double-click it to maximize the window. 
 
Menu bar: Displays menu names which, when clicked, display drop-down menus. 
 
More buttons: Click to open a submenu of additional toolbar buttons. By default, Excel 
will add buttons that you use often to your toolbars, and remove buttons from the toolbar 
that you do not use. 
 
Name box: Displays the cell reference of the active cell. 
 
Office Assistant: Appears when you open Excel, and can answer your questions about 
how to perform a task. 
 
Toolbars: Click toolbar buttons to select commands without opening a menu or dialog 
box. 
 
Status bar: Click toolbar buttons to select commands without opening a menu or dialog 
box. 
 
Status bar: Displays information about the current mode, selected command, or option. 
The right side of the status bar shows the keyboard status. For example, NUM indicates 
that the numeric keyboard is toggled on (number lock). The middle of the status bar 

Notes: 
 In the illustration, there are two sets of Close, Maximize and Minimize 

buttons: One for the Excel application window, and one for the workbook 
window. The Maximize button will appear as a Restore button if the 
window has already been maximized. 



contains the Auto Calculate box. Which displays the result of a selected Auto Calculate 
function (such as SUM or AVERAGE) when applied to a selected range of cells. 
 
Workbook window: Appears in, and is restricted to, the Excel window. Workbook 
windows contain the data that you enter in worksheets (purposely muted in this 
illustration). You can open multiple workbook windows within Excel. 
 
 
 
 
 
 
 
 
 

About Cell Locations 
In the illustration below, cell B2 is the selected cell in Sheet1. 
You know this because: 

 The reference B2 appears in the name box. 

 Excel has outlined the column heading B and the row heading 2. 

 Sheet 1 is the active tab in the workbook window. 
NOTE: The contents of the selected cell also appear in the formula bar. 

                  Name box Formula bar 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

About Cells 
Cells are areas in a worksheet in which you store data. In formulas, you refer to 
cells by specifying their column and row locations in worksheet. This is called a 
cell reference. You can enter text, values and formulas in cells. 

Notes: 
 Each cell is defined by the intersection of a row and a column (e.g.: 

A3 denotes column A & row 3). The cell’s location is called a cell 
reference (or cell address). 

 When you open a new workbook, it usually contains multiple 
worksheets. Each worksheet has 256 columns and 65,536 rows. 
Therefore, each worksheet contains 16,777,216 cells. 

 Columns are labeled A through IV; Rows are numbered 1 through 
65,536. 

 Each cell can store up to 32,000 characters. 
 To select a cell, click it, or press an arrow key in the direction of the 

cell you want to select. 



 
 
 
 
 
 
 
 

About Cell Properties and Controls 
Cells are defined by the intersection of a column and a row. Therefore, the dimensions of 
a cell are defined by the column width and the row height. All cells have borders and fill 
properties. Selected cells have darkened borders and a fill handle (controls). These 
controls let you use a mouse to perform actions on the cell. 
 
Border control: You can drag of a selected cell to move is contents. 
 
Border style: You can apply line styles to one or more of the border of a cell. 
 
Fill: You can color or shade a cell to distinguish it from other cells. 
 
Fill handle: You can drag the fill handle of selected cells to extend their content as a 
series, or, for a single cell, to copy its content to adjacent cells. 
 
Height/width: You can change the column width and row height to adjust the size of a 
cell. 
 
Location: You can identify the location of the selected cell by reading its cell reference 
in the name box (see illustration on previous page). 
                                                                                             Column width      

                
 

 
 
Fill style 

Border style 

Row height 

 
 

 

                                                             Border control              Fill Handle        

  
 
 
 
 
 
 

Notes: 
 A control is any graphical element that allows you to perform an action or 

specify a setting. 
 Excel changes the shape of the mouse pointer when you rest it on a cell 

control, such as a cell border or fill handle. 
 A cell reference indicates a cell’s location. Cell references are often used 

in formulas to calculate values stored in the worksheet. 



 
 
 
 
 
 
 
 
 
 
 
 

Select Adjacent Cell Range 
1. Click first cell you want to select. 
2. Drag mouse through cells to include in selection. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Select Nonadjacent Cell Range 
1. Click first cell and drag through cells to select. 
2. Press and hold Ctrl. Then drag through additional ranges to include in 

your selection. 
 
 
 
 
 
 
 
 
 

Select Cells, Columns and Rows 
When working with worksheets, you will need to select a cell or range of cells to 
complete a variety of tasks. A range may consist of adjacent or nonadjacent cells. 
You can also name and select named cell ranges. Keyboard shortcuts for selecting 
cells are listed in Help, on the Contents tab, under the “keyboard Reference” topic. 

Notes: 
 Excel will scroll the worksheet when you drag the selection beyond the 

visible area of the worksheet. 
 The first cell you select is the active cell (cell A2 in the above illustration). 



 
 

Notes: The first cell in the last range you select is the active cell (cell C10 in the 
illustration). Selecting non-adjacent cells or cell ranges (multiple selections) is often used 
to select data to chart. 

 

 

Select Entire Column or Row 
Click row or column heading to select. 
TIP: You can click this Select All button to select the entire worksheet 

Column heading 

 
 
 
 
 
 
Row 

Heading 

 
 
 

Notes: To select multiple columns and rows, drag through row or column headings, or 
press Ctrl and click nonadjacent headings. 

 
Name a Range 
 

1. Select the range to name. 
 
2. Click in the name box and type descriptive name. 

NOTE: Range names may contain uppercase and lowercase letters, 

numbers and most punctuation characters. They cannot include spaces. 

The underscore character is useful for stimulating a space, as in 

“inventory expenses”. 
 

3. Press Enter. 
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Select a Named Range 
 
Click in named box, then click named to select.   
 

      
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
 You can also name nonadjacent ranges, as shown on 

the previous page. 
 You might want to name ranges that you frequently 

chart or print. 
 You can also use the Go To command (Ctrl + G) to 

select named ranges. 



 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change Column Width Using the Mouse 
 
To set width of multiple columns: 

1. Drag through column headings of columns to change. 
OR 
Press Ctrl and click each column heading to change. 

2. Reset pointer on right border of any selected column heading. 
 

Pointer becomes a 
  

3. Drag pointer left or right to decrease or increase the column size. If you 
have selected non-adjacent column headings, press Ctrl while dragging 
pointer to uniformly change all selected columns. Excel displays width in 
a pop-up box as you drag. 

 
 

 
 
 
 
 Column headings     Pointer 
 

Notes: 
 In step 2, the pointer’s shape indicates when you can perform the action. It must 

be a cross with left- and right-facing arrows, as shows in the illustration. 
 The number of characters of the standard font measures column width. 

 
 
 
 
 
 

Adjust and Hide Columns 
Data appears in cells defined, in part, by the column width. You can control the 
width of columns or hide them. You can also  adjust while print previewing your 

workbook. 

Format Column 

 

Notes: 
 In step 2, the pointer’s shape indicates when you can perform the 

action. It must be a cross with left-and right-facing arrows, as shown 
in the illustration. 

 Column width is measured by the number of characters of the 
standard font. 



 
 
 

Automatically Size Column to Fit Largest Entry 
 

1. Rest pointer on right border of column heading. Pointer becomes a cross 
with arrows facing left and right. 

2. Double-click. 
 
 
              BEFORE DOUBLE-CLICK                                           AFTER 
  
                              
 
 
 
 
 
 
 
 
 
 

Hide Columns by Dragging 

1. Click column heading, and then rest pointer on right border of selected  
 

column heading. Pointer becomes a  

2. Drag pointer left beyond its own left border to hide the column. 
                  BEFORE                                                AFTER 
  

 
 
 
 
 
 

 
 

 
 
 
  
 

NOTES: 
In step 1, you can select multiple columns. 

Notes: 
 In step 1, you can drag through column headings to hide multiple 

columns. 
 You can hide columns to prevent others from seeing the data, or to 

temporarily display columns of data next to each other for charting or 
other purposes. 



 

          Display Hidden Columns by Dragging 
 
 
 
 

1. Rest pointer just to the right of column heading border.  
Pointer becomes a   

2. Drag pointer right to display the hidden column. 
 
 
 BEFORE                                              AFTER 
 
 
 
 
 
 
 

Adjust Columns Using the Menu 
1. Select column(s) to adjust. 
2. Click Format, Column. 
3. Click desired column command. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: In steps 1, when the pointer is a cross with double vertical line 
and left-and right-facing arrows. You can perform the action. 

Notes: 
 Use the menu commands when you find it difficult to adjust columns 

with the mouse. 
 In step 1, when using the menu to unhide columns, select the 

columns to the left and right of the hidden columns. 



 
 

 
 
 
 
 
 
 
 
 
Align Cell Data Using Toolbar 
 

1. Select cells (s) to align. 
NOTE: To select cells that are nonadjacent, you can press Ctrl and click or drag 

through cells. 

2. Click desired alignment button on the Formatting toolbar. 
 
           Align left   Align Center   Align Right 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Align Data in cells 
Align cell data horizontally and vertically, apply text controls (wrap text 
in cells, shrink text to fit, merge cells ): orient text in a variety of 
angles. 

Format 
 

Notes: 
 In step 2, if the desired alignment button is not visible click the More 

Buttons arrow  on the right side of the toolbar to view additional 
buttons. 

 If no alignment is set, Excel applies the General alignment which left-
aligns text and right-aligns values. 



 
 

Merge and Center 
1. Select cell containing data and drag to extend selection to include cells in 

which data will be centered. 
 

 
 
 
 
 
 

2. Click the Merge and Center button                      on the Formatting 
toolbar. 

 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Notes: 
 In step 1, if Merge and Center button is not visible, click the More 

Buttons arrow  to view additional buttons. 
 A merged cell is one or more consecutive cells combined into one cell 

address. 
 When you merge cells, only the contents of the upper-left cell are 

retained. That cell becomes the cell reference. 

Notes: 
 Alignment options: 

Horizontal and Vertical: sets alignment of text in cells. 
 
Wrap text: inserts line breaks when needed and increases row 
height to fit text. 
 
Shrink to fit: shrinks characters to fit the column width. 
 
Merge cells: joins selected cells. The contents of the upper-left 
cell are retained. That cell becomes the cell reference. 

 



 
 
 
 
 
 
 
 
 
 
 
 
Menu Alignment Options 
  
Set alignment options from a dialog box. 
 

1. Select cells. 
2. Click Format, Cells. 

3. Click the Alignment tab. 
4. Select desired options and click OK 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
 Alignment options: 

 
Indent: offsets data from left side of cell. Increments are 
measured in widths of characters. 
 
Orientation: sets the rotation of text. Increments are measured 
in degrees. 

OK 



 
 
 
 
 
 
 
 
 
 
 
Clear Cell Contents 
Removes the contents (data and formulas) and leaves the cells blank in the worksheet 
without removing formats or comments. 

1. Select cells to clear. 
NOTE: To select cells that are nonadjacent, you can press Ctrl and click 

or drag through cells to include in the selection. 

2. Press Delete. 

OR 

 Right-click any selected cell. 

 Click Clear contents. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 

 
 

Clear Cell Contents 
Using menu commands, you can clear cell formats, contents, or 
comments or clear all of these items. 

Edit Clear 

 Cleared cell 



 
  
 
 
 
 
 
 
 
 
 
 

Clear Cell Options Using Menu 
Clear cells formats, contents, comments, or all of these items. 

1. Select cells to clear. 
NOTE: To select cells that are nonadjacent, you can press Ctrl and click 

or drag through cells to include in the selection 
2. Click Edit, Clear. 
3. Click one of the following: 

All  To clear formats, contents, and comments. 
Formats To clear only formats, such border styles and font 

attributes. 
Contents To clear just the contents of the cell. 
Comments To clear just the comment attached to the cell. 
 
Excel clears the cells as directed by your command 
 
 
 
. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
 In step 1, Excel will perform the clear command on all selected cells in 

one step. 
 After you clear cells, you can click Edit menu, then Undo to reverse the 

operation. 
 Notice that after the Clear Contents command has been applied, the 

surrounding cells do not change position. 
 When you clear a cell, the format of the cell, such as bolding or 

alignment, is retained. 

Notes: 
 In step 2, you can point to the Clear command on the menu without 

clicking to open a submenu. 
 Comments are notes inserted into a cell. Excel displays comments 

when you rest the pointer on a cell containing a comment. A red 
triangle in the upper-right corner of a cell indicates the cell contains a 
comment. 



 
 
     
TIP:  You can also clear cell contents by dragging the fill handle in a selection 
over the selected cells. 
 
 
        
 
 
 
 
 
 
 
1     2    3 
 Pointer changes to a   Drag fill handle up. Release mouse to 
 Cross when resting on a      clear the cells. 
 Fill handle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copy Cell Data Using Menu Command 
1. Select cells to copy. 
2. Click Edit, Copy. A flashing dashed outline appears around cells. 
 
 
 

 
 
 
 
 
 
 

Copy Cell Contents 
You can copy data from one cell to another cell in a variety of 
ways. The method you choose often depends upon the 
location of the source and the destination. 

Edit 

 

Edit 

 



 
 
 

 
 
 
 
 
 
 
 
 

3. Select destination cell. 
4. Click Edit, Paste. 

5. Repeat steps 3 and 4 to repeat paste operation. 
6. Press Esc to end the paste procedure. 

TIP:  If you intend to paste the data only once, you can by pass steps 4-6 

and just press Enter. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copy Cell Contents by Dragging Cell Border 
1. Select cells(s) to copy 
2. Point to any border of selected cells (s) 

 
 
 
 
 
 
 

Notes: 
 Using menu commands to copy cells is must useful when both the 

source and destination cells are not in the same viewing area. 
 In step 2, the flashing dashed outline remains until you press Esc, 

press Enter or add input to another cell. The flashing outline indicates 
you can repeat the paste operation. 

 In step 2 and step 4, you can also right click the selected cells to 
access the Copy and Paste commands from a shortcut menu. 

 Caution: when you paste data, existing data in the destination cells will 
be replaced. Click Edit menu, then Undo to reverse the paste 
operation. 

 In step 4, to avoid overwriting data, click Insert menu, then click 
Copied Cells. The Insert Paste dialog box appears from which you can 
choose a direction to shift the existing cells. 

Cell 

border 



 
3. Press Ctrl and drag border outline to new location. 
4. Release mouse button. 
 
 
 

 
 
 
 
 
 

A plus sign indicates data will           Excel displays destination 
be copied (not moved).                      Cell reference 
 
 

 
 
 
 
 
 
 
 

Copy Cell Contents by Dragging Fill Handle 
1. Select cells(s) to copy, then point to fill handle. A crosshair appears. 
 
 

 
 
 
 
 

2. Drag crosshair to extend border over adjacent cells to fill. 
 
 

 
 
 
 
 
 
 
 
 
 

Notes: 
 The drag cell border method is best when the source and 

destination cells are near each other. 
 In step 3, press Ctrl and Shift to copy data and insert it between 

destination cells. Otherwise data in the destination cells will be 
overwritten. 

Crosshair appears when 
pointer rests on fill handle. 

http://www.familycomputerclub.com/excel/autofill-in-excel.html


 
 

3. Release mouse button. Excel copies data into all cells within extended. 
 
 
 

 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1. Select cells to delete. 
 

2. Click Edit, Delete. 

 

If the Delete dialog box appears: 

 Select the direction you want existing cells to shift. 
 

 Click OK 
 
 

Notes: 
 The drag fill handle method can only be used to copy and 

fill adjacent cells. 
 In step 1, if you select more than one cell, press Ctrl 

while dragging to suppress creating a series – a set of 
related numbers or text. 

Delete Cells, Columns, or Rows 
 
You can delete cells, rows or entire columns, from a worksheet. Existing 
cells adjust to take the place of the removed cells. 

Edit Delete… 

OK 



 
 
 
 
 
 

Step 1 

 
 
 
 
  Step 2 
 
    

 
 
 
 
TIP: In step 2, you can also right-click any selected cell, and then click Delete from the 
shortcut menu. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Notes: 
 In step 1, to select nonadjacent cells, you can press Ctrl and 

click or drag through cells to include in the selection. 
 If deleted cells are used in formulas, the formulas will display 

#Ref!  Error messages. If there are references to adjusted cells 
in formulas. Excel adjusts the formulas, even absolute 
references. 

 Caution: You can lose data with the delete action. However, 
you can click Edit menu then Undo to reverse the action. 

 Do not confuse Delete with Clear. Clearing cells removes only 
the data, while deleting cells removes the cells from the 
worksheet. 



 
 

Delete Entire Column or Row 
1. Click row or column heading to select. 
2. Click Edit, Delete. 

Row headings Selected column heading 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
TIP: You can also delete cells by pressing Shift and dragging the fill handle in 

selection over the selected cells. 

1 Pointer changes to a cross when you rest       2   Drag fill handle up over cells while 
   it on fill handle.                                                       Holding the Shift key. 

 
 
 3 Cells are deleted and cells shifts up in  
     this example.                      
 
 
 
 
 

Notes: 
 To select multiple columns or rows to be deleted, drag through row or 

column headings, or press Ctrl and click nonadjacent headings to 
select. You cannot delete columns and rows at the same time, 
however. 



 
 
 

 
 
 
 
 

   
 
 Edit a Cell Entry by Double-Clicking 

1. Double-click cell containing data to edit. 
Excel displays a flashing insertion pointer in the entry and extra controls 
next to the formula bar. 
 
 

 
 
 
 
 
 
         Insertion pointer 

2. Click in the entry to place the insertion pointer. 
OR 
Drag through characters to select (the next action will replace or delete 
your selection). 
 
                           

                                      
3. Edit the entry as needed: 

 Type characters to insert. 

 Press Del to delete characters to the right of insertion pointer or to delete 
the selection. 

 Press Backspace to delete character to the left of the insertion pointer or to 
delete the selection. 

4. Press Enter. 

OR   Click the Enter button  on formula bar. 
 
 
 

Edit Cell Data 
A cell entry can be changed (edited) with a variety of techniques. When 
cell editing is enabled, the formula bar gains extra controls (buttons) and 
displays the cell contents both in the cell and in the formula bar. 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Replace a Cell Entry 

1. Select cell containing data to replace. 
2. Type new data 

3. Press Enter. 

OR Click the Enter button  on formula bar. 
 

 
 
 
 
 
 
 
Cancel Changes to a Cell Entry 
Prior to entering the change: 

 Press Esc. 
OR 

Click the Cancel button  on formula bar. 
 
 

 
 
 
 
 
 
 

Notes: 
There are three ways to edit a cell entry: 

 Double-click the cell. 
 Click the cell, and then click in the formula bar. 
 Click the cell, and then press F2. 

When editing: 

 Excel displays a flashing cursor where new input will be inserted. 
 You can press the Ins key to toggle between insert and overwrite 

mode. 
 The formula bar changes to include Cancel, Enter and Edit 

Formula buttons. 
 When editing a cell, you can insert text stored from the Clipboard 

by pressing Ctrl + V 

Notes: 
Replacing cell data by typing over it is best when little or none of the 

original cell data will be retained. 

Notes: 
 Use Esc to undo your changes prior to completing. 

 If you have already entered the change, you can click the Edit 

menu, then Undo. 



 
 

Formula Bar and Related Controls 
 
Name Box   : Displays cell reference of the data you are editing. 
 

Cancel button   : Lets you cancel a revision before completing it. 
 
 

Enter button   : Lets you complete the revision. 
 
 

Edit Formula button  : Provides help when editing formulas. 
 
Formula bar   : Lets you edit the cell content. 
 
 

                         
 
 
 Name box            Cancel button    Edit Formula button 
                                                          
                                                       Enter button                      Formula button 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Notes: 
 By default, Excel lets you edit cell contents directly in the 

cell.  To set this option, click Tools menu, then Options: 

select the Edit tab: then select Edit directly in cell. 



 
 
 

 
 
 
 
 
 
 
 
 
  
 
 
 

Enter Text or Whole Numbers 
1. Select cell to receive entry. 
2. Type the text or whole number. A flashing insertion pointer appears after the 

data you type. The formula bar also displays your entry. 
 

 
 
 
 
 
 
 
 
 Insertion pointer        Formula bar 

3. Press Enter. OR 

Click the Enter button   on formula bar. 
 
Excel completes the entry and selects the cell below it. 
 

 
 
 
 
 
 
 
 
To cancel the entry before completing it: 

 Press Esc.     OR     Click the Cancel button  on formula bar. 
TIP: To enter identical data in multiple cells, select cells, type data, and then press 

Enter Cell Data 
Entering data is very straightforward. There are, however many 
techniques for entering data of different types, such as dates, fractions, 
percents, and formulas. 



         Ctrl + Enter. 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter Special Kinds of Data 
1. Select cell to receive entry. 
2. Type the data as shown in the table below. A flashing insertion pointer 

appears after the data you type. The formula bar also displays your entry. 
3. Press Enter. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 TIP: To enter today’s date, press Ctrl +;  (semicolon) 

Category: Example of what to type: 

 

Currency $25,000.25 

Date 6/24/97 

 24-June 

 24-June-97 

 June-97 

Date and time 6/24/97 10AM 

Fraction 21/2 

Label Text 

Mixed number 21/2 

Number  25 

Number as label =”25” 

Percent 25% 

Time 10AM 

Formula (simple) =A1+B1 

Notes: 
 In step 2, to wrap text within the cell, press Alt + Enter. 
 In step 2, if what you type matches a previous entry in the 

current column. Excel’s Auto-Complete feature fills in the text of 
the previous entry as you type. 

 In step 3, you can also press an arrow key in the direction of the 
next cell you want to select, or click any other cell. 

 In step 3, if what you enter matches and abbreviation in the 
Auto correct feature. Excel replaces the abbreviation with the 
specified replacement text. 

 If no alignment is chose, Excel applies the General alignment 
which automatically left-aligns text and right-aligns values 
(including dates and times). 

 If your entry does not fit in the column, it overlaps into the next 
column, unless the next column cell also contains data. 



 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

How AutoComplete Works 
 
The AutoComplete feature assists you when entering repeating text in a column. 
 

1. Select cell to receive text. 
2. Type beginning of text. Excel automatically completes the entry (see 

highlighted text in illustration below) based on data previously entered in 
the column. 
 
 

 
 
 
 
 
 
 
 

 NOTE: Type over the highlighted text to change it. 
3. Press Enter. 

 

 
 
 
 
 
 
 
 

Notes: 
 Excel automatically applies special number formats when you 

enter a value in a specific order, or when you enter a value with 

special characters, such as a comma. For example, if you, type a 

zero, a space, and a fraction, Excel will automatically apply the 

fraction format and display the value as a fraction. 

 Dates and times may be displayed as a combination of text and 

numbers. However, Excel stores dates and times as serial values 

and right- aligns them. 

Notes: 

 AutoComplete will not assist in entering numbers. 

 Another way to use AutoComplete it to right-click the cell to receive the 
data, click Pick from List, then select the data you want to enter. This 
method lets you input data using only the mouse. 

http://www.familycomputerclub.com/excel/turn-automatic-data-entries-on-or-off-in-excel-2007.html


 
 
 
 
 
 
 
 
 
 
 
 
 

Format Numbers Using Toolbar 
1. Select cells(s) containing values to format. 

NOTE: To select cells that are nonadjacent, press Ctrl and click or drag 

through cells to include. 

2. Click desired number format button on the Formatting toolbar: 
 
 Currency     percent     comma 
                                                              Decimals Increase / Decrease 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Format Numbers 
When you enter a value, Excel applies the format it thinks appropriate to 
your entry. You can also apply common number formats from the 
Formatting toolbar, such as Currency and Percentage; or you can select 
specific number formats using menu commands and the Format Cells 
dialog box. 

Format… 

 

Notes: 
 In step 2, if the desired number format button is not visible, click the More 

Buttons arrow on the right side of the toolbar to view additional buttons. 

 When you change a number format, Excel does not change the value. 

 If the number does not fit in the cell after you change the number format, 

Excel displays ########(pound signs) in the cell. To fix this problem, 

increase the column width, or select the Shrink to fit option. 

 You can format a number when you enter it by typing specific symbols, 

such as a $ or %. 

http://www.familycomputerclub.com/excel/formatting-text-and-numbers-in-excel-2007.html


 

Format Numbers Using Menu Commands 
 

1. Select cell(s) containing values to format. 
NOTE: To select cells that is nonadjacent, Ctrl and click or drag through 

cells to include. 

 
2. Click Format, Cells. 

3. Click the Number tab. 
 

4. Select category of number format in Category list. Excel displays options for 
the selected category. 

 

5. Select options for the category you have selected. Excel displays sample in 
Sample box. 

 

6. Click OK                     when done. 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OK 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Category Value Comment 

General 1.5  

Number 1.50  

Currency $1.50  

Accounting $1.50  

Date January1, 1990 First day of century 

Time 1/1/00 12.00 PM First day and a half of century 

Percentage 150.00% You can set decimal places 

Fraction 11/2  

Scientific 1.50E+00  

Text 1.5  

Special 00002 Zip code 

 (718) 980-0999 Phone number 

 000-00-0002 Social security number 

Custom 1/1/1900 12.00PM Customized date and time 

Notes: 
 In most cases, Excel applies the General number Format, unless 

you include special characters. 
 In step 4, the selected category indicates the current number 

format of the selected cell. If more than one cell is selected, and 
they have different number formats, no category will be displayed. 

 The Custom category contains templates for all the number 
formats. Select the format that is closest to the desired format, 
and then modify it as needed. In the sample below, the custom 
format (date and time) shows the full year 1900. 

 You can hide data in a cell by applying a custom number format. 
To create the format: Select Custom in Category box, then type 
three semicolons (;;;) in the Type box that appears. 

 
          
 
 
 
 
 Excel displays descriptions of the selected category near the 

bottom of the dialog box. 
                  



 
 
 
 
 
 
 
 
 
 
 
 

Move Cell Contents using Menu Commands 
 

1. Select cell(s) to move. 
2. Click Edit, Cut. A Flashing dashed outline appears around selected cell(s). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

3. Select destination cells(s). 
4. Click the Edit menu, and then click Paste. 

OR 

Press Enter. 

 

 
 
 
 
 
 
 
 
 
 
 

Move Cell Contents 
You can move data from one cell to other cell in a variety of ways. 
The best method to choose depends upon the location of the source data 
and its destination. 

Edit 

 

Edit 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Move Cell Contents by Dragging Cell Border 
1. Select cells(s) containing data to move. 
 
2. Point to any border of selected cells (s). 
 
 

 
 
 
 
                                          Pointer becomes a solid arrow 
 

3. Drag border outline to new location. 
 
4. Release mouse button. 

  
 
 

 
 
 
 
 Excel displays reference of destination cell. 
 
 
 

Notes: 
 Using menu to move cells is best when the source and destination cells 

are not in the same viewing area. 
 In step 2 and step 4, you can also right-click the selection to select the 

Cut and Paste commands from a shortcut menu. 
 Caution: when you paste data, existing data in the destination cells will 

be replaced. Click the Edit menu, and then Undo to reverse the paste 
operation. 

 In step 4, to avoid overwriting data, you can click the Insert menu, and 
then Cut cells. The Insert Paste dialog box will appear, from which you 
can choose the direction to shift the existing cells. 

 You may have to click the button at the bottom of the menu to view the 
Cut  Cells command. 



 
 
 
 
  
 
 
 
 
 
 
 
 
 

Move Part of a Cell’s Contents into Another Cell 
1. Double-click cell containing data to move. A flashing insertion pointer 

appears. 
2. Drag through data to select it. 

 
Excel highlights data in cell 

 
3. Press Ctrl + X (Cut). 
4. Double-click destination cell and click where data will be inserted. 

 
OR 
Select cell to be overwritten by data. 

5. Press Ctrl + V (Paste). 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 

Notes: 
 The drag border method is best when the source and 

destination cells are near each other. 
 In step 3, “drag” means to press and hold the left mouse button 

while moving the mouse. 
 In step 3, to avoid overwriting data ion destination cells, press 

Ctrl + Shift while dragging cell border.  Existing cells will shift to 
accommodate new data. 

 

Notes: 
 You can also use menu commands (Edit, Cut and Edit, 

Paste) to move a cell’s content. 
 If you make a mistake, you can click the Edit menu, then 

click Undo. Excel lets you undo multiple actions, not just the 
most recent. 



 
 
 

 
 
 
 
 
 
 
                                    

 
  
 
 

Group and Ungroup Sheet Tabs 
When you group sheets, data and formatting changes made to the active sheet are 
repeated in the grouped sheets. 

1. Click first sheet tab in group. 
2. Press Ctrl and click each sheet tab to add to group. 
 
 
 

 
 Active sheet       Grouped sheets. 

3. Click any grouped sheet tab to make it active. 
 
To ungroup sheet tabs: 

 Right-click any grouped sheet tab, then click Ungroup Sheets 
on the Shortcut menu. 

Delete Sheet Tabs 
1. Right-click sheet tab to delete, then click Delete on the shortcut menu. 
 
2. Click OK 

To confirm the action. 
 

Caution: Be careful when deleting worksheets, because you cannot undo this 

action 

 
 
 
 
 
 

 

Sheet Tabs 
Sheet tabs let you work with multiple worksheets within a single 
workbook file. You can select, group, insert, rename, delete, move, 
and copy sheet tabs. 

OK 



 
 

 
 
 
 
 
 
 
 
 
 
 
 

Insert a New Sheet 
1. Right-click any sheet tab, and then click Insert on the shortcut menu. The 

Insert dialog box appears. 

2. Click Worksheet icon, then click OK 
 
3. Move and rename sheet tab as desired. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
 In step 2, you can also press Shift and click to select 

consecutive sheets. 
 Grouped sheets appear highlighted (white), while ungrouped 

sheets appear gray. When sheets are grouped, “(Group)” 
appears after the workbook name on the title bar. 

 You can also ungroup sheets by clicking any sheet tab that is 
not currently grouped. 

OK 

Notes: 
 In step 1, you can insert multiple worksheets by first selecting 

(grouping) the number of sheets you want to insert, then right 
clicking on that group. 

 In step 2, you can also insert special items, such as chart and 
macro sheets. 

 From the Spreadsheet Solutions tab, you can select a custom 
template to insert. 



 

Rename a Sheet 
1. Double-click sheet tab to rename. Excel highlights the sheet tab name. 
 
 

 
 

2. Type new name, then click anywhere in the worksheet. 
 

 

 
 
 
 
 
 
 
 
 

Move and Copy Sheets 
1. Select sheets(s) to move or copy. Excel highlights sheet tab names. 
2. To move sheets, drag selection to desired location. 

 

 
 
 
 Triangle marks insertion point. 

 OR 
 To copy sheets, press Ctrl and drag selection to desired location. 
 
  
 
 
                                            

  Plus sign indicates copy 

 
 
 

 
 
 
 
 
 
 

Notes: 
 In step 1, you can also right-click the tab to rename, then click 

Rename from the shortcut menu. 
 Worksheet names may contain spaces and punctuation. 

Notes: 
When you copy a sheet. Excel renames the new sheet by adding a 
number to it. For example, a copy of Sheet 1 may be named Sheet 
1 (2). You can, of course rename the sheet. 



 
 
 

 
 
 
 
 
 
 
 
 
 

            
 

Formula Location 
Enter a formula in the cell where the result should appear. As you type the formula, it 
will appear in the cell and in the formula bar. After you enter a formula, the result is 
displayed in the cell, and the formula is displayed in the formula bar. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

About Formulas 
You will use formulas to calculate values stored in your worksheet.  
This topic explains basic information about formulas - formula 
location, formula parts, controlling the order of operation, and formula 
examples. 

              Formula result                Formula        

Notes: 
 A formula is an instruction to calculate numbers. 
 You can display formulas in cells by pressing Ctrl +~(tide). 

Press the key again to return worksheet to normal. 



 

 
 
Formula Parts 
 
Formulas always begin with an equal sign (=) and often contain elements such as those 
shown in bold type in the following sample formulas: 
 
Numbers  =A1+25 

Cell references =A1-25 

Reference names =A1*Salary 

Functions  =Sum (A1:A10) + Salary 

Operators  =A1/2+25*22-3 

Parentheses  =(24+A1)/2% 

 
 
 
 
 
 
 
 
 
 
 

 

Control the Order of Operations in Formulas 
It is important to consider the order of mathematical operati0ons when preparing 
formulas. Excel will perform the operation in your formulas in the following order: 

 Operations enclosed in parentheses( ) 
 Percentage % 
 Exponential ^ 
 Multiplication and division * / 
 Addition and subtraction + - 
 Concatenation (connection of text strings) & 
 Comparisons =< > <=> = < > 

 
 
 
 
  
 

Notes: 
 Cell references and reference names indicate the location of cells 

in a worksheet. 
 Functions are predefined formulas. 
 Operators tell Excel the kind of calculation to perform. 
 Parentheses – affect the order of operations. They must be used 

in pairs. 

 

Notes: 
 When a formula contains both a multiplication and division operator, 

Excel performs the operations from left to right. 
 When a formula contains both an addition and subtraction operator, Excel 

performs the operations from left to right. 



 

Formula Examples 
 
This is a list of common formulas with a brief explanation: 
 
=A1+25 adds the contents of cell A1 to the constant 25. 
 
=A1-25 subtracts 25 from the content of cell A1. 
 
=A1*TotalSalary multiplies the content of cell A1 by the content of the cell named 
Total Salary. 
 
=Sum (A1:A10)+TotalSalary adds the content of the cell named TotalSalary  to 
the  sum of cells A1 through A10. 
 
=A10+(25*TotalSalary) multiplies the content of the cell named TotalSalary by 25, 
then adds that result to the content of cell A10. 
 
=A10^3  multiplies the content of A10 by itself 3 times (exponentially). 
 
=(Min (Salary)+Max (Salary))/2  adds the minimum value in the range of cells 
named Salary to the maximum value in that range, and divides the result by 2. 
 
=A10& “ “ & A11   combines the text in cells A10 and A11 with a 
space between them. If A10 contains HELLO and A11 contains THERE, the result 
would be HELLO THERE. 
 
=IF (A1< >0, A1*B10,” “)  If the value in cell A1 is not zero, multiplies 
A1 by the value in B10, otherwise displays blank text. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
Some of the examples contain named ranges. You must name a 
range before you can refer to it in formula. However, Excel will let you 
use names when labels exit next to numbers in your worksheet. 
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Build Formula (Add References) 
1. Select cell to receive formula. 
2. Type an equal sign (=). The equal sign displays in the cell and in the formula 

bar. 
 
 

 
 

 
 
 

3. Type the formula. 
To insert a reference in formula by pointing with the mouse: 

 Click cell to reference. A dashed line appears around the cell, 
and Excel inserts the cell reference in your formula. 

 
 
 

 
 
 

4. Type next part of formula. If formula is complete, go to step5, below. Excel 
removes dashed outline, and your entry appears in cell and formula bar. 

5. Press Enter. 
OR 

Click the Enter button      on formula bar. 
Excel calculates the formula and displays the result in the cell. 
 

 
 
 
 
 
 

Create Formulas (Simple) 
Enter and build formulas to calculate values stored in your worksheet. 
This section includes basic information about building formulas, pasting 
names into a formula, and inserting references in formulas. 



 
 
 
 
  
 
 
 
 
 
 
 
 
 
 

Paste a Named Range into a Formula 
1. Pace insertion point in formula. 
2. Click Insert, Name. 
3. Click Paste on the submenu. 
4. Click name to paste in formula, then click OK  

 

 
 

 
 
 
 
 
 
 
 
 
 
  
 
 
 
 

 
 
 
 
 
 

Notes: 
 In step1, select a cell in which you want to enter the result of the 

calculation. 
 In step2, when you type the equal sign, controls appear on the formula 

bar. 
 In the illustration, the simple formula =25*A1 multiplies the value in A1 

by 25. 
 You can insert references until all the cells you want to calculate are 

included in the formula. 
 In you decide to cancel the entry, press Esc. 

OK 

Notes: 
In step 2, you can also type the name of a range, instead of pasting it. 



 
 
 
Create Formula, Insert Cell References, and Change Reference 
Type 

1. Type the data in a new worksheet, as shown in the illustration following. 
Then create the formula in C7 to calculate the commission (=$B$2*C5) 

 
 
 
 
 
 
. 

 
 
 
 
 
 

2. Select cell to receive formula (C7). 

3. Type = to start the formula. 

4. Click cell for reference in formula (B2). 

               ` To change the inserted reference to absolute: 

  Press F4.  Reference changes to absolute (B2 becomes $B$2). 

5. Type desired operator (*). 

6. Click next cell for reference in formula (C5). 

7. Press Enter to complete the formula. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Notes: 
 This procedure explains the steps needed to build a typical 

formula. References to the illustration appear in 
parentheses. 

 When creating a formula, each time you point to a cell, 
Excel inserts it in the formula and outlines the cell. 

 In step 4, each time you press F4, and Excel changes the 
reference type. 

 Illustration result: 
Formula in C7 should display 1360. 



 
 
 
 

 
 
 
 
 
 
 
 
  
 
  
                 Paste Function button                Functions list on formula bar 
 

Insert a Function Using Function Wizard 
1. Select cell in which to create the function. 
 

2. Click the Paste Function button  on Standard toolbar. The Paste 
Function dialog box appears. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

3. Select desired category in Function category list. 
4. Select desired function in Function name list, then click OK. A dialog 

box for the function you selected appears. 
 
 

  
 
 
 

Create Functions 
Functions are predefined formulas that perform specific calculations, 
such as finding an average or future value. Functions require 
arguments – the data to be calculated.  To make it easy to create a 
function, Excel provides the Paste Function Wizard. 



 
 
 
 
 
 
 
 
 
 

5. Insert cell references or value in Number boxes. 
NOTE: You can click the Collapse Dialog button on the right side of the 

Number box, then select cells directly from the worksheet. 

 
6. Click OK                                                                                  

 When done. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit a Function 
1. Select cell containing the function to edit. 

NOTE: Do not double-click the cell. 

2. Click the Paste Function button          on Standard toolbar. 
3. Change arguments in Number boxes, then click OK. 

 

 
 
 
 
 
 
 
 

OK 

Notes: 
 In step 2, you can also click the Insert menu, and then click Function. 

 You can also click the Paste Function button when you want to insert a 
function in a formula you have already started to create. 

 When creating a formula, you can click the Function list on the formula 
bar to insert frequently used functions and access the Paste Function 
Wizard. 

 The Paste Function Wizard may insert a suggested range in a 
Number Box. Delete this range it is not appropriate. 

 As you click in a Number box, the Paste Function Wizard may add 
more boxes. 

Notes: 
 In step 1, if you double-click the cell, then click the Paste Function 

button; you will insert a new function. 
 In step 3, refer to illustration  given at beginning of the page. 



 

Combine (Nest) Functions 
1. Double-click cell containing function(s). 
2. Place insertion point where new function will appear, or select 

argument to replace with a function. 

3. Click the Paste Function button          on Standard toolbar. 
4. Select desired category in Function category. 
5. Select desired function in Function name list, then click 
6. Insert cell references or values in Number boxes. 
7. Click OK when done. 

 
 

 

Use AutoSum Function 
1. Click cell in which function will be entered. 

2. Click the AutoSum button  on the Standard toolbar. Excel 
surrounds suggested cells to add with dashed outline. 

3. To change the range, drag through desired 
cells. 

4. Press Enter when done. 
 
 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

OK 

OK 

Notes: 
 If Excel detects subtotals within a range of values, it may 

suggest to add just those totals to obtain a grand total. 

When this occurs, Excel applies dashed outlines only to 

cells containing subtotals in the immediate column or row. 
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Edit Formulas 
1. Double-click the cell containing the formula to change. Excel 

displays a flashing insertion pointer in the formula. Cell references 
in the formula are colored. Cell outlines indicate locations of 
references in worksheet. 

 

 
 
 
 
 
 
 
 
 
 
 

2. Click in the entry to position the insertion pointer. 
OR 
Drag through characters to select. 

 
3. Edit the entry as needed: 

 Type characters to insert. 

 Press Del to delete characters to the right of insertion pointer or 
to delete the selection. 

 Press Backspace to delete characters to the left of the insertion 
pointer or to delete the selection. 

 Follow steps described on the next page to change reference or 
extended a cell range. 

4. Press Enter or click the Enter button   on formula bar.  OR 

To cancel the change: 

Press Esc, or click the Cancel button   on formula bar. 
 

Edit Formulas 
You will sometimes need to change a formula – perhaps replace an 
operator, add a set of parentheses, or change the cell or range to which 
the formula refers. 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Change Reference in Formula 
1. Double-click the formula to edit. Excel outlines references 

in worksheet with colored borders. 
2. Point to border of outlined reference in worksheet. Pointer 

becomes an arrow when positioned on border. 
3. Drag border to desired cell or range. 
 
 

 
 
 
                         Action: Drag border to cell containing new value to calculate. 
 
 Result: 
 
 
 
 
 

 
 Reference change 
 
      Border    Fill handle    Reference change   
 
 
 
 
 
 

Notes: 
 After you double-click the cell, Excel displays the formula in the 

cell and on the formula bar. 
 To insert a function, click desired location in formula, then click 

the Functions button to the right of the formula bar (it shows 
the last function selected). Follow the prompts to insert the 
function 

 In step 2, if you drag through characters, your next action, such 
as typing, will replace the selection. 

 If the edited formula displays an incorrect result, click the Edit 

menu, then Undo Typing to undo your change. 

Notes: 
 Excel assigns a difference color to each border and reference to help you 

identify them. 
 In step2, the fill handle is a small square in the lower-right corner of the 

outlined reference. 



 
 

Extend Cell Range in Formula 
 

1. Double-click the formula to edit. Excel outlines references in 
worksheet with colored borders. 

 
2. Point to fill handle of outlined reference in worksheet. 

Pointer becomes a  when positioned on fill handle. 
 

3. Drag fill handle in direction to extend the range. 
  
 
 
 
  
 
 
 
 
 
 
 
 

 
 Reference change A1: A5 becomes A1:B5 
 
 
 
                                      
  
 
  
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Print Button 
 

Settings that Affect Print Results 
Before printing a worksheet or workbook, consider this checklist of settings that will 
affect print results. 
 
Headers and footers: Prints repeating information at the top and bottom of each page. 
 
Page breaks: Determines locations in worksheet where printed pages end and new pages 
begin. 
 
Margins: Determines locations in worksheet where printed pages end and new pages 
begin. 
 
Orientation: Determines whether the page prints in portrait or landscape orientation. 
 
Print area: Prints a specified area of the worksheet. 
 
Repeating print titles:  Prints column titles are the top of left side of each new printed 
page. 
 
Scale: Determines the size of the worksheet information will be when printed. 
 
Sheet options: Sets print options: such as gridlines, page order, draft quality, and black 
and white printing. 

 
 
 
 
 
 
 
 

 

Print Workbook Data 
The Print feature lets you print the current worksheet, a selection in a 
worksheet, or an entire workbook. Additionally, you can specify which 
pages to print, collate printed pages, print multiple copies, and print to a 
file. 

 
  

Notes: 
Consider using Print Preview 
to check how the worksheet 
will print prior to printing it. 

Notes: 
If necessary, to show additional buttons 

on a toolbar, click More Buttons  on 
the right side of the toolbar. 
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Print Using Toolbar 
1. Select worksheets, worksheet cells, or chart object to print. 

OR 
Select any cell to print current worksheet. 

2. Click the Print button  on the Standard toolbar. 
 

Print Using Menu 
1. Select worksheets, worksheet cells, or chart object to print. 

OR 
Select any cell to print current worksheet. 

2. Click File, Print. The Print dialog box appears. 
 
 
 

 
 
Change printer 
 
 
 
 
 
 
 
 
 
Click 
to 

preview 
 
 
 
To indicate what to print: 

 Select Selection, Entire workbook or Active sheet (s). 
To specify pages to print: 

 Select All, or select pages to print in From and To boxes. 
To disable collating of printed pages: 

 Deselect Collate. 

To print multiple copies: 

 Select number of copies in Number of copies box. 
To print to a file: 

 Select Print to file. 
 

3. Click OK  
 

OK 



 

 

 

        Plot Area    Value Axis                   Chart area      Legend 
                                                  Major Gridline 
 
 
 
     Value Axis 

 
  
 
 
 
 
 
 
 
 
               Series” Pies” Point      Category Axis      Legend 
Key 
  
                                      Series “Muffins” Point 
 
 
 
 
 

 
 
Identify Chart Items 
The default Clustered Column chart type shown above includes the following items. Item 
properties are also described. 
 
Category Axis (X Axis) – the horizontal line on which categories of data are usually 
plotted. Properties include the format and alignment of category names and the scale of 
names and tick marks. 
 

About Chart Items 
While you create and modify charts, you will be presented with many 
choices and settings. Understanding the items in a chart and their 
properties will make it easier for you to design you own. 

Notes: 
When you rest the pointer on any chart item, Excel displays a pop-up label 
identifying the name of the item. 



Chart Area – the space inside the chart. It includes the base peroperties of the chart, such 
as font style for chart text, background color, and how the chart moves or sizes when 
cells around it change. 
 
Legend – a box containing a label and legend key for each series in the chart. Properties 
include its border, font, and placement. 
 
Legend Key – a graphic in the legend whose color or pattern corresponds to a series in 
the chart. Legend key properties include border, color, shadow, and fill effects. 
 
Plot Area – the area within which the chart axes and series data is drawn. The properties 
include its border, area color, and fill effects. 
 
Series – a group of data markers or series points that visually describe the values plotted. 
For example, the Series “Muffins” describes the number of muffins sold in each category 
(1995,1996, 1997). 
 
Series Point – a single item in a data series that visually describes the value for one 
category. For example, Series “Pies” Point indicates a value of 345 for the category 1995. 
The properties for series points include border and pattern, data labels, and options such 
as overlap and gap width. 
 
Value Axis (Y   Axis) – the vertical line that describes the values of series points in the 
chart. Properties include line and tick marks, scale of major and minor values, font for 
displayed values, number style of values, and text alignment. 
 
Value Axis Major Gridlines – a set of lines that visually define values across the plot 
area.  These gridlines help determine the value of a given series point in the chart. 
Properties include color, style, pattern, and units of values. 
 
 

 
 
 
 

Notes: 
 To review the properties of any chart items, rest the pointer on the 

item. When Excel displays the item name, double-click to display 
the Format dialog box for the item. 

 Charts of different types have items or properties particular to their 
type. For example, pie charts have properties for a series that 
describe the angle of the first slice, while line charts have 
properties such as drop lines and up-down bars. 



 
        
  

               Chart Wizard button 
 

Create a Chart 
1. Select cells containing labels and values to chart. 

NOTE: You can change this selection as you proceed it you 

discover that you require different data. 

2. Click Chart Wizard button    on Standard toolbar. 
From Chart Wizard – Step 1 of 4 – Chart Type: 

  

   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a. Select chart type and subtype (see Select Chart type). 
 

b. Click the Next button 
 
 
 

Create a Chart 
Chart Wizard provides prompts and options for selecting the chart type, the 
source data, chart options, and chart location. 

1 

Next > 
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From Chart Wizard – Step 2 of 4 – Chart Source Data: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

a. Select Data Range and Series option (see Set Source of Chart Data). 
 
b. Click the Next button   
 
 

Notes: 

 Your selection will determine the orientation of the series in your chart. 
You can change this orientation in Chart Wizard – Step 2 of 4 on the 
Data Range tab. 

 Avoid blank rows and columns when selecting data to chart. Use the 
Ctrl key and drag through ranges to create a multiple selection and 
omit blank cells. 

 You can hide rows and columns that do not pertain to data to be 
charted. 

 In Chart Wizard, you can click Next > or <Back to move forwards or 
backwards to any step. 

 Chart Wizard – Step 1 of 4: Select the chart type, then the subtype, 
Click and hold the Press and hold to view sample button to preview 
how the selected chart type will plot your chart. 

Next > 



 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

From Chart Wizard – Step 3 of 4 – Chart Options: 

 

 

 
 

a. Select desired Chart options (see Set Chart Options). 
 
b. Click the Next Button 
 
 

Notes: 
Chart Wizard – Step 2 of 4: 

 From the Data Range tab, you can change the range of data to plot, or 
change the orientation of the data series to columns or rows. 

 From the Series tab, you can add and remove series and change 
references to series names, data ranges, and the category (X) axis 
labels. 

Chart Wizard – step 3 of 4: 

 From the Chart Options dialog box, you can set options for chart 
titles, axes, gridlines, legend, data labels, and the data table. You can 
return to this dialog box after the chart is created. 

Next > 



 
 
 

 
 
 
 
 
 
 
 

 
From Chart Wizard – Step 4 of 4 – Chart Location: 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

a. Select As new sheet or As object in (see Set Location of Chart). 
 
 
b. Click the Finish button 
 

 

Notes: 
Chart Wizard – Step 4 of 4: 

 From the Chart Location dialog box, you can change the 
proposed destination sheet, or the proposed chart sheet name. 

 You can click Finish from any Chart Wizard step to create the 
chart with default options. 

 

Finish 


